Optimize Puget Sound

PeopleSoft Budget Administration Training Agenda

Brought to you by: Accounting & Budget Services

Contact us at: ABS@pugetsound.edu

Visit us on the web at: http://www.pugetsound.edu/about/offices--services/accounting--budget-services/

See our organizational chart at: http://www.pugetsound.edu/files/resources/4182_Org_Chart_ABS.pdf

Electronic version of this document: http://www.pugetsound.edu/about/offices--services/technology-services/optimize/optimize-puget-sound-training/training-handouts/

Objective

In this course, we will introduce you to and assist you with learning:

- PeopleSoft terminology and navigation related to administering and viewing your university budget;
- the “chart of accounts” structure used by Puget Sound in PeopleSoft so you can code transactions in the purchasing system;
- how to code non-purchase order (PO) disbursements for payment (including vendor invoices, reimbursements, and expense advances); and
- how to use the delivered PeopleSoft budget inquiry tool.

Our goal is for you to leave Budget Administration with a solid grasp of coding Puget Sound financial transactions and using PeopleSoft’s budget inquiry tool. This foundation prepares you for purchasing training on submitting and approving requisitions.

Discussion Items

- PeopleSoft Navigation & Terminology
  - Logging into PeopleSoft
  - Searching for an existing value
  - Coding transactions vocabulary
  - Finding account values through the crosswalk tool
- Coding Non-Purchase Order (non-PO) Requests for Payment
  - Required and optional accounting information to supply
  - Non-PO forms and payment procedures
- PeopleSoft’s Budget Inquiry
  - Learning the types of budgets; key terminology/concepts
  - Creating and interpreting “saved searches” for the type of budget you manage
  - Using the advanced “saved search” criteria, matrix, and tips
- Budget Inquiry – Beyond the Basics
  - Personalizing the budget inquiry results table
  - Exporting the budget inquiry results table to Excel
  - Viewing the budget inquiry graphical representation
  - Drilling down to supporting activities
- Where to Get Additional Help

Preparation

PeopleSoft Help contains instruction videos on how to use PeopleSoft and is available at: https://pshelp.pugetsound.edu/pshelp.
Table of Contents

Navigation to the University of Puget Sound PeopleSoft Financials ......................................................... 4

Supported PeopleSoft Browsers* .................................................................................................................. 5

Basic PeopleSoft 9.1 Navigation .................................................................................................................. 6

Searching for an Existing Value ..................................................................................................................... 8

Coding Transactions ...................................................................................................................................... 11

Crosswalk Tool ........................................................................................................................................... 12

Preparing for PeopleSoft’s Budget Inquiry: Finding Your Index in Cascade ............................................. 14

Banner Budget Admin to PeopleSoft Saved Search Worksheet ................................................................. 16

Types of Budgets at Puget Sound ................................................................................................................ 17

PeopleSoft Budget Inquiry Key Terminology/Concepts .............................................................................. 19

Coding non-purchase order (non-PO) requests for payment from PeopleSoft .......................................... 20

High level overview of payment cycle ......................................................................................................... 20

Required and Optional Accounting Information to Supply ......................................................................... 21

To code a non-PO payment request, you will need: ................................................................................ 21

Reviewing Banner to PeopleSoft Crosswalk on what you will need ...................................................... 21

Looking up PeopleSoft accounting values (skip if you know your PeopleSoft values) .......................... 21

Non-Purchase Order (non-PO) Forms to Submit for Payment .................................................................. 24

Summary of forms and purpose .................................................................................................................. 24

Disbursement Stamp Instructions ............................................................................................................... 24

Disbursement Request Form Instructions .................................................................................................. 26

Advance Processing Instructions ................................................................................................................ 27

Budget Inquiry .............................................................................................................................................. 29

Interpreting the Budget Inquiry Results Page .............................................................................................. 35

Budget Inquiries – Beyond the Basics ......................................................................................................... 44

Personalizing the Budget Inquiry Results Table ....................................................................................... 44

Changing the Column Order ....................................................................................................................... 44

Changing the Sort Order ............................................................................................................................ 45
Changing the Columns to be Hidden ........................................................................................................... 46
Changing the Column to be Frozen .............................................................................................................. 47
Exporting the Budget Inquiry Results Table to Excel ..................................................................................... 48
Viewing the Budget Inquiry Graphical representation .................................................................................... 49
Drilling down to supporting activities .......................................................................................................... 50
Advanced Saved Search Structures ............................................................................................................. 51
   Reviewing the 9 Recommended Saved Search Criteria ................................................................................. 51
Recommended Saved Search Matrix ............................................................................................................. 52
Where to Get Additional Help ...................................................................................................................... 53
**Navigation to the University of Puget Sound PeopleSoft Financials**

**Step 1.** Navigate to Cascade [https://cascade.pugetsound.edu/cascade/cascade.menu](https://cascade.pugetsound.edu/cascade/cascade.menu).

**Step 2.** Log into Cascade.

![Puget Sound Login](image)

**Step 3.** Click on **PeopleSoft Financials** hyperlink from Cascade Menu Items.

![PeopleSoft Financials](image)

**Step 4.** Reenter your Active Directory (AD) password at PeopleSoft login page below.

![PeopleSoft Enterprise](image)

**Signing Off:** Properly signing off the system is important when you are finished working. Signing off disconnects you from the system and prevents unauthorized access.
**Supported PeopleSoft Browsers**

**Desktop Computers**

- Firefox 2.x, 3.x, 4+
- Internet Explorer 7, 8, 9
- Safari 3.2, 4.x, 5.x
- Chrome 1+

**Mobile**

- BlackBerry Browser 4
- WebKit-based mobile browsers (iPhone Safari, Android Chrome, Nokia S60)
- Access NetFront 3
- OpenWave (UP Browser) 7
- Opera Mini 8
- Pocket Internet Explorer for Windows Mobile 5, 6
- Safari (iOS) 4.3, 5+
- Other Basic XHTML mobile browsers

*Supported PeopleSoft Browsers as of July 2012 provided by Oracle.*
Basic PeopleSoft 9.1 Navigation

The two frequently used navigation tools in PeopleSoft are the Universal Navigation Header and the Menu.

Universal Navigation Header
The Universal Navigation Header, found at the top right of every page, includes several links.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Returns you to your Home page</td>
</tr>
<tr>
<td>Worklist</td>
<td>Shows your workflow items, if any, with summary information</td>
</tr>
<tr>
<td>Add to Favorites</td>
<td>Allows you to bookmark the current component so it would be available under the ‘Favorites’ Menu</td>
</tr>
<tr>
<td>Sign Out</td>
<td>Logs you out of PeopleSoft</td>
</tr>
</tbody>
</table>

Menu
You can access any page within PeopleSoft by starting at the Home Page.

Simply select a menu item to see the sub-menus and components available to you; your security profile defines what you see.

If more than one component is associated with a menu option, then a cascading menu, also known as a submenu, displays to the side of the menu item.
Using My Favorites

Using the Universal Navigation Header, you can mark Favorites. Favorites are similar to browser “bookmarks” for frequently visited content.

You may mark a favorite from either a search page or a data page, but using the link will always return you to the search page.

After clicking on Add to Favorites, PeopleSoft prompts you to name the Favorite, providing you with the default. You may accept the default or change it to something more meaningful to you. It must be unique.

After verifying the description, click OK to store it under My Favorites.

Once you save a Favorite, expand the My Favorites folder.

You may change the name and/or order of your Favorites

You may also choose to delete a Favorite. When you choose to delete an entry, PeopleSoft will ask you to confirm, using a warning message.

Click the SAVE button at the bottom of the page to confirm your changes.
**Searching for an Existing Value**

There are several different ways to search. Whenever you are looking for data, PeopleSoft will provide you with options, called **Search Dialog**, to help you search for a particular row or group of rows.

Being more specific with your search criteria will help narrow the Search Results. This is important since PeopleSoft will return a maximum number of rows. If your criteria are not specific enough, the search will return more than 300 rows from the database (some pages only return 100).

When this happens, PeopleSoft returns the first 300 rows sorted in the order designated by the database.

For example, click on the Search button without entering any search criteria below. There are easily more than 300 crosswalks in the database. It would indicate this by displaying a message above the Search Results grid.

Your next step would then be to attempt to narrow your Search.
Operators
PeopleSoft provides you with 10 Operators for each field to help you narrow your Search. When entering Search criteria, you can enter a full or partial value for any field displayed on the Search Page. Based on what you enter, the system presents a list of possible matches or, if there is only one match, the page(s) you requested.

Case Sensitivity
Many fields in PeopleSoft are case sensitive. To open up your searches and avoid missing possible matches because of capitalization issues, leave the case sensitive checkbox unchecked when searching.

Basic Search
A basic search page enables you to search by just one field at a time and then only using the “Banner Index” operator.

Advanced Search
On the advanced search page, you can narrow your search by searching based on more than one field at a time and by using a variety of search operators. You can enter full or partial values for the key fields.

Searching With Lookup or Drop Down Button
PeopleSoft makes it easier for you to search with look up values that you might wish to use as search criteria. Whenever a pre-established prompt is used in searching, PeopleSoft provides you with a Drop Down or Lookup button.
Wildcards

PeopleSoft applications support three wildcard features when searching for data in character fields. These wildcards can be helpful in finding the exact information you want to process. The following are the supported standard wildcard features.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ (underscore)</td>
<td>Match any single character</td>
</tr>
<tr>
<td>%</td>
<td>Match one or more characters</td>
</tr>
<tr>
<td>\ (backslash)</td>
<td>Escape character—do not treat the next character as a wildcard.</td>
</tr>
</tbody>
</table>

**Example:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
<th>Results</th>
</tr>
</thead>
</table>
| Name1   | Contains | sm_th | Smathering  
Blacksmiths  
Peter H. Smith  
Smithers, Mike  
Janet Smith   |
| Name1   | Contains | ste%n | Aster’s Perfect Nails  
Katie Stephen  
Kathryn, Stephan  
Steve and Maria Coffee  
Café Stephanie |

Search Page Buttons

The following buttons exist on all search pages:

- **Search**: Processes the search once you have entered search criteria.
- **Clear**: Clears entered text from all fields on the page (without saving) so that you can enter new criteria.
- **Save Search Criteria**: If you perform the same search often, you can save the search criteria.

Search Results

Once PeopleSoft has listed the returned rows in the Search Results grid, use your browser’s scroll bar.

PeopleSoft sorts the Search results in the order designated by the tables holding the data. You may reorder the Search results by clicking the underlined name of that field at the top of the Search Results.
**Coding Transactions**

The chart of accounts has been restructured in PeopleSoft (PS). The objective of this section is to cover the basic information on PS chartfield values including PS funds, and how this translates PS values from Banner codes.

**Changing from Banner to PeopleSoft**

[Diagram showing Flow from Banner to PeopleSoft]

**PeopleSoft fund = primary source of funding**

- 10 - Educational & General Operating
- 13 - Auxiliary Enterprises
- 15 - Faculty Enrichment & Student Research-Unrestricted
- 17 - Designated Projects
- 18 - Designated Operations and Reserves
- 19 - ASUPS
- 24 - Faculty Enrichment & Student Research-Restricted
- 25 - Gifts – Restricted Current
- 26 - Endowment Payout – Restricted
- 27 - Grants – Restricted Private and Government
- 91 - Reserves-Minor/Revolving Facilities Projects
- 92 - Reserves-Facilities/Equipment
- 93 - Gifts-Restricted Facilities
- 94 - Reserves-Major Facilities Projects

- In addition to account, all transactions require a PS fund* and PS department* code
- SpeedCharts will be used to help you code the correct Chart-of-Accounts for transactions
## Crosswalk Tool

Optimize Puget Sound Project has developed a crosswalk tool to help translate Banner codes to PS codes.

<table>
<thead>
<tr>
<th>Step 1.</th>
<th>Sign into PeopleSoft through Cascade.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2.</td>
<td>Navigation:</td>
</tr>
<tr>
<td></td>
<td>Main Menu &gt; Puget Sound Financials &gt; How do I code my expenses now?</td>
</tr>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td>Step 3.</td>
<td>Look up normal expenses and revenues.</td>
</tr>
<tr>
<td></td>
<td>For Example: Enter ‘70051’ for Banner Acct.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>o Click on the <strong>Search</strong> button.</td>
</tr>
</tbody>
</table>
Step 4. Review Results.

Click on Return to Search at the button left corner to return to previous page.

- For coding purpose, use Search on Banner Index to review the PeopleSoft SpeedChart translation.

- The crosswalk is limited to Operating and Capital Expenses and Revenues and does not include compensation expense or balance sheet accounts.
**Preparing for PeopleSoft’s Budget Inquiry: Finding Your Index in Cascade**

Cascade provided the accounts you manage (called indexes) in a drop down menu. These are the codes that you will learn to translate into PeopleSoft values using the Crosswalk tool.

<table>
<thead>
<tr>
<th>Step 1.</th>
<th>Sign into Cascade.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 2.</strong></td>
<td>Click on the <strong>Budget Administration</strong> hyperlink.</td>
</tr>
<tr>
<td><img src="image1" alt="Cascade Home for Julie Ray Collins" /></td>
<td></td>
</tr>
<tr>
<td><strong>Step 3.</strong></td>
<td>Select the <strong>View by Index</strong> hyperlink.</td>
</tr>
<tr>
<td><img src="image2" alt="Budget Administration" /></td>
<td></td>
</tr>
</tbody>
</table>
Step 4. You will see the **Select an Index** drop down box showing all your budgets.

![Select an Index](image1.png)

Step 5. You can click on the drop down menu to view all your indexes/budget accounts.

![Index Selection](image2.png)
<table>
<thead>
<tr>
<th>Banner</th>
<th>PeopleSoft</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Types of Budgets at Puget Sound

There are 5 budget categories that may apply to your administration of budgets at Puget Sound.

<table>
<thead>
<tr>
<th>Budget Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating (Department) Budgets</td>
</tr>
<tr>
<td>ASUPS Budget</td>
</tr>
<tr>
<td>Carryover funds</td>
</tr>
<tr>
<td>Grants and Projects</td>
</tr>
<tr>
<td>Facilities and Technology Projects</td>
</tr>
</tbody>
</table>

### Operating (Department) Budgets

- **Educational & General - Fund 10**
  - Primary source of funding - student tuition (also gifts, endowment, and other sources)
  - Organized by division/president’s cabinet members
    1. President
    2. Office of Communications
    3. Enrollment/Admission
    4. Academic Division
    5. Student Affairs
    6. University Relations
    7. Finance & Administration
- **Auxiliary - Fund 13**
  - Primary source of funding – student fees/sales (also faculty/staff sales and department recharges for supplies/services)
  - Bookstore
  - Dining & Conference Services
  - ResNet
  - Student Housing

### ASUPS Budget

- **Fund 19**
  - Primary source of funding – student government fee
  - Operations
  - Programs
  - Media
  - Clubs that receive budget allocations (do not carry over their balances)
**Carryover funds**

“Accounts” (Project in PeopleSoft) that carry over their balances from one year to the next. Spending is for the designated or restricted purpose up to the available balance in the account (or possibly less if required by a division or department policy).

- a. Department General Gift Funds
- b. Faculty Travel Funds
- c. Athletic Summer Camp and Designated Funds
- d. ASUPS Clubs that carryover their balances and do not receive ASUPS budget allocations
- e. Facilities and Equipment Reserves
- f. Donor-Restricted Funds, including gift and endowment payout/spending

**Grants and Projects**

- a. Externally Funded Grants, primarily faculty research and student financial aid/work study
- b. University Enrichment Committee (UEC) faculty and student grants

**Facilities and Technology Projects** - various
**PeopleSoft Budget Inquiry Key Terminology/Concepts**

Budgets are referred to as “Commitment Control” in PeopleSoft.

Commitment Control tracks or controls expenditures actively against predefined, authorized budgets. Commitment Control enables Puget Sound to:

- Create and maintain track or control budgets.
- Track or check actual transactions against control budgets.
- Track or check imminent future financial obligations (pre-encumbrances and encumbrances) against control budgets.
- Track or check recognized revenue against revenue estimate budgets.

**Procurement and Commitment Control Cycle**

<table>
<thead>
<tr>
<th>Budget Ledger</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXPDETAILS</td>
<td>Detailed Expenditure Budgets</td>
</tr>
<tr>
<td>EXPSUMMARY</td>
<td>Summary Expenditure Budgets</td>
</tr>
<tr>
<td>REVDETAILS</td>
<td>Detailed Revenue Budgets</td>
</tr>
<tr>
<td>REVSUMMARY</td>
<td>Summary Revenue Budgets</td>
</tr>
</tbody>
</table>
**Coding non-purchase order (non-PO) requests for payment from PeopleSoft**

**High level overview of payment cycle**

---

**Purchase Order Payment Cycle**

1. Invoice
2. Accounting Information
3. Requisition
4. Accounting Information
5. P.O
6. Accounting Information
7. Invoice
8. Voucher
9. Payment

**Non-Purchase Order (non-PO) Payment Cycle**

1. Disbursement Stamp
2. Invoice
3. Disbursement Request
4. Travel/Exp Advances
5. Accounts Payable
6. Voucher
7. Payment
Required and Optional Accounting Information to Supply

To code a non-PO payment request, you will need:

- PS SpeedChart
- PS Account
- PS Chartfield1, if applicable

Reviewing Banner to PeopleSoft Crosswalk on what you will need

Looking up PeopleSoft accounting values (skip if you know your PeopleSoft values)

<table>
<thead>
<tr>
<th>First Step</th>
<th>Log into PeopleSoft.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Navigation</th>
<th>Main Menu &gt; Puget Sound Financials &gt; How do I code my Expenses now?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For more detailed guidance, see “How do I code my expenses now?” hand out or UPK recording topic: “Crosswalk: How do I code my expenses now?” under PeopleSoft Navigation within PeopleSoft 101.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PS SpeedChart:</th>
</tr>
</thead>
</table>

[Image of PS SpeedChart]
- Look up your PS SpeedChart by typing in your Banner Index and click Search.

- Your Banner Index is always 6 digits or characters. You can use the “contains” search operator if you don’t know the full 6 digits.

- Change the Banner Index search operator to “contains” and type in as much of your Banner Index as you know. Click Search.

- If you don’t know your Banner Index, you can look it up by name using:
  1. Cascade Budget Administration>View by Index>Select an Index; or
  2. Cascade Banner Tools>FOAPAL Search>Index Search.

**PS Account:**

- The PS Account Description line is the last search criteria row in the Banner-to-PeopleSoft Crosswalk “Find an Existing Value” tab.

- Use the “contains” search operator with the PS Account Description to search for the PS Account number based on a portion of its description (example: supplies).
PS Chartfield1:

- Type in your Banner Activity (Actv) code and click Search.
- If you don’t know your Banner Activity (Actv) code, you can look it up in Cascade Budget Administration or by using Cascade Banner Tools>FOAPAL Search>Activity Search.
- How Chartfield1 codes can be used: to track budget and actual at a program, event, or activity level.
  - Theatre department can have different Chartfield1 codes so track revenues and costs by each production.
  - Optimize Puget Sound project can track the cost of implementing individual PeopleSoft modules (e.g. Campus, HR/Payroll, Financials, Analytics).
  - Alumni Programs can use Chartfield1 code to track the revenues and expenses associated with each event.

- When you have your PS SpeedChart, Account, and Chartfield1 (if applicable), you are ready to code your non-purchase order payment request.
### Non-Purchase Order (non-PO) Forms to Submit for Payment

Requisitions and Purchase Orders are covered under separate procedures. This section is intended for Non-Purchase Order related submission for payment.

**Summary of forms and purpose**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Request payment for:</th>
<th>Disbursement Request Form</th>
<th>Advance Processing Form</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• non-PO Invoice</td>
<td>Disbursement Request for when you <strong>do not</strong> have an invoice or are requesting reimbursement and <strong>do not</strong> use the preferred Wells Fargo CCER Out-of-pocket Expense reporting system</td>
<td>Request for travel or expense advance</td>
</tr>
<tr>
<td></td>
<td>• non-PO Contract</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Disbursement Stamp Instructions**

<table>
<thead>
<tr>
<th>Step 1.</th>
<th>Stamp and fill in accounting information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>o Locate a clear space on your vendor invoice to place your stamp.</td>
</tr>
<tr>
<td></td>
<td>o Using the back of the invoice will work fine.</td>
</tr>
</tbody>
</table>

If there is no clear space on the front or back of the vendor invoice

- Stamp any other blank paper which is big enough for the stamp
- Please staple (do not paperclip) the stamped paper to the **back** of the invoice.

*(Most information AP staff need to reference is included on the face of the vendor invoice.)*
Please do not use disbursement or date stamps on the vendor remittance copies and/or coupons. They need to be returned to the vendor with payment to ensure correct payment processing by the vendor.

Example of the disbursement stamp

| Highlight PO Number on Invoice or List Here | Final Payment / Close PO? | Yes ☑ No ☑ Fiscal Year ______ |
| US Mail unless otherwise indicated here | Indicate FOAPAL if No PO or Different from PO FOAPAL: |
| SpeedChart (6 or 8 digits/characters) | Account (5 digits) |
| Chartfield1 (optional, as applicable) |

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>

Disbursement Request Description:

1. 
2. 
3. 

Budget Administrator: In signing I acknowledge the receipt of goods, any changes to the FOAPAL(s), and approve payment of this invoice for the amount indicated.

Signature __________________________________________ Date _____________

- Complete the necessary fields on the disbursement stamp, including the signature and date lines.

  - For coding in PeopleSoft:
    1. Fill in PeopleSoft Account values
    2. Cross out Index
      ➢ Fill in SpeedChart (either 6 or 8 digits/characters)
    3. Cross out Activity (if applicable)
      ➢ Fill in Chartfield1 (if applicable)

  For the time being, you may continue to use your Banner values if this will help you make this transition.

- For coding in Banner:
  1. Fill in Banner Account values
  2. Fill in Banner Index
  3. Fill in Activity (if applicable)
<table>
<thead>
<tr>
<th>Step 2.</th>
<th>The budget manager (or another individual with disbursement authority) signs and dates the stamped document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3.</td>
<td>Send the invoice with Disbursement Stamped data to:</td>
</tr>
</tbody>
</table>
| | Accounts Payable  
| | Campus Mail Box (CMB) 1042 |
| | Or deliver to Jones Hall Room 018. Accounts Payable (Jones 018)  
| | Monday – Friday, 8 am – 5 pm, except university holidays. |

**Disbursement Request Form Instructions**

- When approving non-purchase order vendor invoices, statements, or contracts for payment, the disbursement stamp is recommended to save time over a Disbursement request form.
- You may find the Disbursement Request Form works better for specific situations. If so, please use the steps below.

**Step 1.**

- Download Disbursement Request Form
  - Time saving tip: the form opens in Excel. You can save the forms on your local or share drive, by using the “File>Save As” command. This will allow you to fill in and save information that will be the same each time you complete the form.
Optimize Puget Sound Training

Step 2. Complete Disbursement Request Form

Step 3. Attach original receipts or other supporting documentation as applicable.
   - If helpful to you in organizing your receipts, complete and attach the optional Travel Expense Form (Summary).

Step 4. Obtain approval by the budget manager or someone with disbursement authority.

Step 5. Send approved form with required accounting information to:
   - Accounts Payable
     - Campus Mail Box (CMB) 1042
   - Or deliver to Jones Hall Room 018, Accounts Payable (Jones 018)
     - Monday – Friday, 8 am – 5 pm, except university holidays

Advance Processing Instructions

Step 1. Complete Advance Processing Form
   - Provide required and optional accounting information
     - SpeedChart
     - Account
     - Chartfield1 (optional)

Advance Processing Form

- If you are requesting a travel or expense advance, please use the Advance Processing Form

University of Puget Sound
Accounts Payable
X 0650 or X 3408

TRAVEL OR EXPENSE ADVANCE PROCESSING FORM

All requests for advances must be accompanied by supporting documentation or a detailed explanation if no documentation is available

Travel or Expense Advance
(Note: $50.00 or less will be disbursed in cash by Accounts Payable staff - Jones 018)

Charge to:
   SpeedChart (6 digits/characters): ____________________________
   For AP use: Account: 14050

Expense to: ____________________________
   Account (5 digits): ____________________________
   Chartfield1: ____________________________

Pay to: ____________________________
   Amount ____________________________

Requested by: ____________________________
   Contact Phone ____________________________

Approved by: ____________________________
   Department ____________________________
<table>
<thead>
<tr>
<th>Step 2.</th>
<th>Obtain approval by the budget manager or someone with disbursement authority.</th>
</tr>
</thead>
</table>
| Step 3. | Send approved form with required accounting information to:  
Accounts Payable  
Campus Mail Box (CMB) 1042  
Or deliver to **Jones Hall Room 018**, Accounts Payable (Jones 018)  
- Monday – Friday, 8 am – 5 pm, except university holidays |
**Budget Inquiry**

The **Saved Searches** feature of PeopleSoft Budget Inquiry enables you to save budget search criteria that is specific to the type(s) of budget(s) you manage or need to view.

**Walk Through:** Detailed Revenue and Expense Budget

Create a search to view department operating budgets that contain both revenue and expense.

**Step 1.** Decide which of the four budget ledgers that you would need to assess your committed amount(s).

Since you manage a budget with both Revenue and Expense, in this case you would need the following Budget Ledger Groups:
- EXPDETAILS: Detailed Expenditure budgets
- REVDETAILS: Detailed Revenue Budgets

Accounting & Budget Services created a combination ‘Ledger Inquiry Sets’ to link the Expenditure and Revenue Detailed Budget Ledgers:

| Ledger Inquiry Set | DETAIL = EXPDETAILS linked to REVDETAILS |

**Step 2.** Know your valid PeopleSoft ChartField values to use for your inquiry.

For revenue and expenditure detailed budget inquiry, you will need the following:

<table>
<thead>
<tr>
<th>ChartFields</th>
<th>Required?</th>
<th>Value(s) to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Fund</td>
<td>Yes</td>
<td>E&amp;G 10 or Aux 13</td>
</tr>
<tr>
<td>Chartfield 1</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>Optional</td>
<td></td>
</tr>
</tbody>
</table>

**Step 3.** Navigation to PeopleSoft Budget Inquiry (to create a saved search):
Step 4. Click on the ‘New Window’ link to open another new window. This will give you the multiple window option so you may lookup other crosswalk value.

Step 5. Since you have not yet created and saved an Inquiry, click on the Add a New Value link to add a name of the inquiry for future reference.

Step 6. As a suggestion, enter ‘OPERREVEXP’ as the name of this inquiry name. This is a 10 character field, alternatively, enter any name value, up to 10 characters that makes sense to you. (You will search for this name for future inquiries.)
Once you click the Add button, you will see this page open. We will walk through each section of this page next.

**Step 7.** Enter a description of this budget inquiry.

**Step 8.** Click on the drop down button for *Ledger Group/Set* and select *Ledger Inquiry Set*.

**Step 9.** Click on the *Lookup* button to select a Ledger Inquiry Set.
Step 10. Select the **DETAIL** set (which contains both the Expenditure & Revenue Budgets).

![Image of Business Unit and Ledger Inquiry Set selection]

To review what you have so far, this is what you should have under the **Budget Type** section:

![Image of Budget Type selection]

The **DETAIL** Ledger Inquiry Set is setup to pull in both Expense and Revenue Detailed Budget Ledgers. Furthermore, it’s also segregating details with and without Annual Budget (AB).

Step 11. From this default setting, **UNSELECT** the Budget Ledger without Annual Budget (AB).

![Image of Budget Criteria with selected ledgers]
Step 12. Again, by default, Include Closing Adjustments are unchecked. Check to include closing adjustments on the right column for Budget Ledger with Annual Budget (AB):

To review what you have so far, this is what you should have under the **Budget Criteria** section:

Step 13. Refer to the worksheet from Step 2, enter your Department and Fund. Alternatively, you can use the Lookup button to search for your Department and Fund.
Step 14. Click on the Save button to save your inquiry name.

If the Saved message appears on the upper right corner by the Universal Navigation area, you’ve saved your work. Congratulations! Good job.

Step 15. Click the Search button near the top left-hand side of the screen to retrieve your budget information.
**Interpreting the Budget Inquiry Results Page**

Now that you’ve saved your Budget Inquiry name, let’s review your budget results.

<table>
<thead>
<tr>
<th>Step 1.</th>
<th>Click on the <strong>Budgets Overview</strong> menu item at the top left corner of your page.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Budgets Overview" /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2.</th>
<th>In Step 5 of the Walk Through, you added an Inquiry Name by clicking on ‘Add a New Value’ link. The system has since saved your Inquiry Name. Now, click on the <strong>Search</strong> button to retrieve your saved Inquiry.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Budgets Overview" /></td>
<td></td>
</tr>
</tbody>
</table>
Step 3. Since this is the only saved Inquiry, the system opens up the saved page. Click on the **Search** button to search for your commitment information.

If you receive the following information, you have not done anything wrong. One of two possible reasons would result in this message:

- There is no budget that exists based on the criteria of your Inquiry or
- You do not have security access to the budget based on your criteria of your Inquiry.
There are 3 sections on the resulting page. We will review each section here.

**Section (1) notes:**
- Notice that **Revenue Associated** is checked. This Inquiry was constructed using both Revenue and Expense Budget Ledger.
- **Return to Criteria** link will take you back to the page that launched this page.
- The **Max Rows** here is default to 100. This limits the maximum number rows you see to the first 100 of the details on section 3.
If you saw this message as this page open, it will indicate that the number of detail lines on section 3 exceed the allotted setting of 100.

You will also note that only 100 detail lines are shown on section 3.

To see more rows, change the default Max Rows and refresh your results.

Section (2) notes:
This is a summary section with the itemized aggregates of your budget criteria.
**Section (3) notes:**
There are many details to cover in this section. We will review each element, starting with the scroll bars.

<table>
<thead>
<tr>
<th>Account</th>
<th>Budget Period</th>
<th>Budget</th>
<th>Expense</th>
<th>Encumbrance</th>
<th>Pre-Encumbrance</th>
</tr>
</thead>
<tbody>
<tr>
<td>60010</td>
<td>2013</td>
<td>300.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>60010</td>
<td>2013</td>
<td>100.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>60010</td>
<td>2013</td>
<td>200.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>60010</td>
<td>2013</td>
<td>750.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>60010</td>
<td>2013</td>
<td>450.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
</tbody>
</table>

Note the horizontal and the vertical scroll bars. Click and hold your left mouse and drag the vertical bar up and down or the horizontal bar right and left to see additional information.

Hover the mouse over any of the column headings and note you can sort on any of the columns.

You can also hover over any of the dollar amounts in **Blue** to drill down to the supporting details.
The first page of supporting details is the **Activity Log**. Activity Log shows each transaction that makes up the amount and the budget-checking transactions that are updated with budgets.

- The horizontal scroll bar will show additional details related to each activity to the right.
- Click on the Drill Down button to see additional supporting details.
The drill down page shows the source transaction line represented by this commitment control transaction line number. Depending on the transaction type, you can view related document ID, such as voucher ID.

Click on the OK button to return to the previous page.

When it returns to the Activity Log page (where you originated the Drill Down), click on the OK button to return to the page before it.
Back to the Budget Overview Results page, you can click on the "Show Budget Transaction Types" icon displays information about the composition of the budget in a particular row/line (account).

<table>
<thead>
<tr>
<th>Ledger Group</th>
<th>Fund Code</th>
<th>Department</th>
<th>Project</th>
<th>ChartField 1</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXPDETAILS</td>
<td>10</td>
<td>2011</td>
<td></td>
<td></td>
<td>60010</td>
</tr>
<tr>
<td>EXPDETAILS</td>
<td>10</td>
<td>4000</td>
<td></td>
<td></td>
<td>60010</td>
</tr>
<tr>
<td>EXPDETAILS</td>
<td>10</td>
<td>4001</td>
<td></td>
<td></td>
<td>60010</td>
</tr>
<tr>
<td>EXPDETAILS</td>
<td>10</td>
<td>4002</td>
<td></td>
<td></td>
<td>60010</td>
</tr>
</tbody>
</table>

For Puget Sound, Budget Transaction Types include:

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original</td>
<td>= Permanent (ongoing) budget</td>
</tr>
<tr>
<td>Adjustment</td>
<td>= Adjustment to ongoing budget</td>
</tr>
<tr>
<td>Transfer Adj. or Transfer Original</td>
<td>= Temporary (one-time or single year)</td>
</tr>
<tr>
<td>Closing</td>
<td>= Generally not applicable</td>
</tr>
<tr>
<td>Roll Forward</td>
<td>= May apply in limited circumstances</td>
</tr>
</tbody>
</table>

Click on the **Return** button to return to the previous page.
From the Inquiry Results page, click on the Return to Criteria link from either the lower left corner or the bottom of the top section to return to the search page.
**Budget Inquiries – Beyond the Basics**

**Personalizing the Budget Inquiry Results Table**

From most result grids, including the Budget Overview Results grid, you can use the Personalize link to:

- Change the order of the columns
- The sort order
- Which columns are hidden
- Which columns are frozen

You control these settings on the Personalize Column and Sort Order page, which you open by clicking the Personalize link in the grid's navigation header. Any personalization that you make to a grid remains in place until you change them.

**Changing the Column Order**

**Step 1.** Select the **Personalize** link on the grid.

**Step 2.** Under the Column Order, select the column that you want to move.

**Step 3.** To change the sequence, highlight column name, then press the up/down button.
Step 4. Click OK to save your changes and return to the transaction page.

Changing the Sort Order

Step 1. Select the **Personalize** link on the grid.

Step 2. Under the Column Order, select the column that you want to sort.

Step 3. To change the sort order, highlight column name, then press the ‘right’ button to bring it over to the right box.

- Recommend sort order to sort:
  - Ledger Group (desc) - descending so revenue appears on the top
  - Then ascending by
    - Fund
    - Dept
    - Project
    - Chartfield 1
    - Account
    (So transactions will be grouped in that order vs. the default order of by Account)

Step 4. Click OK to save your changes and return to the transaction page.
Changing the Columns to be Hidden

Step 1. Select the **Personalize** link on the grid.

![Personalize link on grid]

Step 2. Under the **Column Order**, select the column that you want to hide.

Step 3. To hide the column, highlight column name, then click the **Hidden** box.

- Recommend hiding
  - Ledger Group
  - Percent Available
  - In doing so, most of the other columns will fit on the page without needing to scroll to the right
  - When revenue budgets are included, recommend hiding:
    - Uncollected Revenue (Rec-Coll)
    - 0.000

Step 4. Click **OK** to save your changes and return to the transaction page.
Changing the Column to be Frozen

Step 1. Select the **Personalize** link on the grid.

![Budget Overview Results grid]

Step 2. Under the Column Order, select the column that you want to freeze.

Step 3. To freeze the column, highlight column name, then click the Frozen box.

![Personalize Column and Sort Order]

Step 4. Click **OK** to save your changes and return to the transaction page.

- Do not use the following features at this time:
  - Copy Settings
  - Share Settings
  - Delete Settings
Exporting the Budget Inquiry Results Table to Excel

You can download Budget Inquiry Results grids to Excel:

**Step 1.** Select the **Download** link on the grid.

**Step 2.** When browser display the popup dialog box to ask you what to do, select Open with MS Excel, and click OK.

**Step 3.** If MS Excel displays this warning message about file extension, allow it to open by clicking on the Yes button.
**Viewing the Budget Inquiry Graphical representation**

To see a graphical representation about a specific control budget, use the Budget Details page.

**Step 1.**
Select the **Show Budget Details** icon on the budget line of interest.

**Step 2.**
Click on the **Display Chart** button.

**Step 3.**
One of 2 types of graph will appears:
- A two dimensional bar chart will be displayed whenever the budgeted amount is not equal to zero.
- 2) A two dimensional pie chart will be displayed whenever the budgeted amount is zero or when a budget ledger does not exist.
Step 4. Click the **OK** button to return to previous page.

**Drilling down to supporting activities**

You can drill down to see the supporting activity log for:
- Budget
- Expense
- Encumbrance
- Pre-Encumbrance

**Step 1.**
- Click any of these value links to display the Activity Log page.

**Step 2.**
- Click Drill Down to access the drill down page for the source transaction line represented by this commitment control transaction line number.
- Depending on the transaction type, you can view related document ID, such as voucher ID.
Advanced Saved Search Structures

The Saved Searches feature of PeopleSoft Budget Inquiry enables you to save budget search criteria that is specific to the type(s) of budget(s) you manage or need to view.

Reviewing the 9 Recommended Saved Search Criteria

<table>
<thead>
<tr>
<th>#</th>
<th>Saved Search</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>OPERREEXP</td>
<td>Dept operating budgets with revenue and expense (compensation, operating, and capital)</td>
</tr>
<tr>
<td>2</td>
<td>OPEREXPALL</td>
<td>Dept operating budgets to view all expense (compensation, operating, and capital)</td>
</tr>
<tr>
<td>3</td>
<td>OPRCPTLEXP</td>
<td>Dept operating budgets to view only operating and capital expenses (no compensation)</td>
</tr>
<tr>
<td>4</td>
<td>OPREXPONLY</td>
<td>Dept operating budgets to view only operating expense (no compensation or capital expenses)</td>
</tr>
<tr>
<td>5</td>
<td>ASUPS</td>
<td>ASUPS operations, programs, media, and clubs that do not carryover over balances</td>
</tr>
<tr>
<td>6</td>
<td>GRANTS</td>
<td>Faculty research grants, UEC faculty enrichment or student research grants, federal student financial aid and federal/state work study,</td>
</tr>
<tr>
<td>7</td>
<td>GRANTSREV</td>
<td>Private grants with revenue and expense budgets</td>
</tr>
<tr>
<td>8</td>
<td>PROJECTS</td>
<td>Facilities PMM, renovations, building construction, telecom upgrade, Optimize Puget Sound project</td>
</tr>
<tr>
<td>9</td>
<td>CARRYOVER</td>
<td>Faculty travel funds, Dept general gifts, Athletic camps, ASUPS clubs that carryover balances, facilities or equip reserves, donor-restricted gifts &amp; endowment spending</td>
</tr>
<tr>
<td>#</td>
<td>Saved Search</td>
<td>Description/examples (Fund # in parenthesis)</td>
</tr>
<tr>
<td>----</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>OPERREVEXP</td>
<td>Dept operating budgets (10, 13) with revenue and expense (compensation, operating, and capital)</td>
</tr>
<tr>
<td>2</td>
<td>OPEREXPALL</td>
<td>Dept operating budgets (10 or 13) to view all expense (compensation, operating, and capital)</td>
</tr>
<tr>
<td>3</td>
<td>OPRCPTEXP</td>
<td>Dept operating budgets (10 or 13) to view only operating and capital expenses (no compensation)</td>
</tr>
<tr>
<td>4</td>
<td>OPRXONLY</td>
<td>Dept operating budgets (10 or 13) to view only operating expense (no compensation or capital expenses)</td>
</tr>
<tr>
<td>5</td>
<td>CARRYOVER</td>
<td>Faculty travel funds (18), Dept general gifts (18), Athletic camps (18), ASUPS clubs that carryover balances (18), facilities or equip reserves (32), donor-restricted gifts (25, 33) &amp; endowment spending (16)</td>
</tr>
<tr>
<td>6</td>
<td>GRANTS</td>
<td>Faculty research grants (27), UEC faculty enrichment or student research grants (15 or 24), federal student financial aid and federal state workstudy (27)</td>
</tr>
<tr>
<td>7</td>
<td>GRANTSREV</td>
<td>Private grants with revenue and expense budgets (27)</td>
</tr>
<tr>
<td>8</td>
<td>ASUPS</td>
<td>ASUPS operations, programs, media, and clubs that do not carryover balances (19)</td>
</tr>
<tr>
<td>9</td>
<td>PROJECTS</td>
<td>Facilities FMM(31), renovations (34), building construction (34), telecom upgrade (34), Optimize Puget Sound project (11)</td>
</tr>
</tbody>
</table>
## Where to Get Additional Help

<table>
<thead>
<tr>
<th>TS Service Desk</th>
<th>In PeopleSoft, click on the button displayed in the search results page to contact the Service Desk as seen below.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you are having trouble and cannot find a code that you need, please contact the Service Desk.</td>
</tr>
<tr>
<td></td>
<td>Feel free to call the Service Desk at 253.879.8585 or email them at <a href="mailto:servicedesk@pugetsound.edu">servicedesk@pugetsound.edu</a>.</td>
</tr>
<tr>
<td>PeopleSoft Help</td>
<td>PeopleSoft Help, adapted from Oracle’s User Productivity Kit (UPK), provides self-paced animated videos developed by the project team to guide you through each topic.</td>
</tr>
<tr>
<td></td>
<td>You can locate these videos from the Cascade Menu. In the description field for PeopleSoft Financials, there is a Learn More link to the right-hand side. The full URL is <a href="https://pshelp.pugetsound.edu/pshelp">https://pshelp.pugetsound.edu/pshelp</a>.</td>
</tr>
</tbody>
</table>